Using CASTLE

Installation
CASTLE runs on the Windows platform.  It should run on any 32 bit version of Windows, but has only been tested on Windows XP.  Currently, the entire program is in just two files, “Castle.exe” and “Castle.hlp”.  The second is just a help file and is not really required for use.  To install CASTLE, just create a new folder, such as “C:\CASTLE”, and copy these two files into that folder.  (But, you could just run “Castle.exe” from anywhere if you wanted).  If you want to create a desktop shortcut, just select the “Castle.exe” file from within Windows Explorer and then “Paste Shortcut” onto your desktop.  If you want to add CASTLE to your Start Menu, right-click on the “Start” button and select “Explore”.  Navigate to the “Programs” folder and “Paste Shorcut” there also.
Schematic Entry
Start CASTLE by double-clicking on “Castle.exe” or a shortcut you may have created during installation.  The main CASTLE window and a blank schematic should appear as shown in Fig. 1.  The schematic view is zoomed so that the entire schematic is visible.  The default schematic sheet size is A (11”x8.5”), but this can be changed at any time.  The default filename is “Untitled Schematic1” and appears in the main windows’ title bar.  Note that an “*” is added to the end of the filename in the title bar to indicate that a schematic has changes since the last save.
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Figure 1.  Blank schematic that appears when starting CASTLE.

Note that CASTLE is programmed using Microsoft’s standard MFC doc/view program architecture and classes so that usage of CASTLE is very similar to other familiar Windows programs.  Several schematic windows can be simultaneously opened.  Use the “Window” menu to select the visible window or to cascade several windows.
CASTLE Toolbars

Nearly all the tools you need to enter a schematic and simulate it are provided on four toolbars.  These toolbars can be moved (but CASTLE currently does not save the toolbar positions).  The main toolbar is on top and provides the standard “New”, “Open”, “Save”, “Copy”, etc., buttons found in many Windows programs.  “Undo” and “Redo” buttons are also provided.  Next, there are four buttons that control the zoom of the schematic window.  Next, are two buttons that turn on or off the drawing grid.  It is recommended to keep the grid on while drawing.  Next, are two buttons that control snapping to the grid.  It is recommended to keep snapping to the grid.
The second toolbar is the Stella toolbar.  If you are not using Stella, you can ignore this toolbar.  Otherwise, you can use this to select the current path where files with be exported to or imported from.  The current Stella path appears in the status bar at the bottom of the main window.

The next toolbar is the parts toolbar.  This toolbar contains all the parts you can use to draw your schematic.  You can hover your mouse over any of the buttons for a pop-up description of each button.

The last toolbar is the simulator toolbar.  The “View Netlist” button will display the current text netlist listing that would be passed to the simulator.  This button is only really helpful for troubleshooting errors in the schematic.  After you schematic is drawn (and SAVED!!!), use the “Simulate” button to activate the simulator interface.  A window will then appear to enter the start and stop times, etc.  After your circuit has been simulated the “Trace Select” will be active.  Use this button to show the trace select window where you can select traces to be plotted or exported.
Note that CASTLE saves the all data after a simulation so that the voltage and current for any point in the circuit is available after the simulation.  For this reason, you select traces of interest after the simulation.

Schematic Entry and Simulation Example:  Simple RC circuit

This example shows the basic method of drawing a schematic, simulating, and plotting the results for a simple RC circuit.  The first step is to place the capacitor.  First, click the capacitor symbol on the parts toolbar (fifth from the left) to switch to capacitor placement mode.  At this point a capacitor and a small circle will appear in the schematic window.  If you move your mouse around the schematic window the small circle and capacitor will follow the mouse.  The small circle represents the mouse position and the left end of the capacitor (the positive end) will also follow the mouse, but be snapped to the grid as shown in Fig. 2.  Rotate the capacitor 90 degrees by pressing “R” key on your keyboard once so that the capacitor is vertical with the positive terminal on top.  Note that all parts rotate about their positive terminal.  
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Figure 2.  Partial screenshot of Castle schematic in capacitor placement mode.

Now, place the capacitor on the schematic by clicking the left mouse button once.  Once placed, terminals will appear on the capacitor ends and default name and value labels appear.  A new capacitor now follows the mouse for placement.  But, since we only need one, exit capacitor placement mode and enter part select mode by either pressing the “Esc” button on your keyboard or selecting the “part select” tool on the parts toolbar (an arrow icon, second from the left).  Now, a standard mouse arrow icon follows the mouse.  Use this tool for selecting parts or labels.  Select the capacitor by clicking it.  The capacitor will turn red when selected.  It can now be rotated or moved (by dragging with the mouse).  Double-click on the capacitor to bring up the edit dialog box.  Change the value to 100n and change the IC (initial condition) to “IC=1”.  Click the “Visible” checkbox so that the IC will be displayed on the schematic and then push “OK”.  Now, your schematic should appear like that in Fig. 3.  Note that all part values and units use the convention of SPICE (i.e., 100n is 100e+9, 1m = 1e-3, 1MEG=1e+6; capacitance in F, inductance in H, resistance in Ohms).  Note also that all fields are case insensitive in CASTLE.  
Next, place a resistor to the right of the capacitor by selecting the place resistor tool from the part toolbar (first button on the left) and clicking on the schematic, just the same way as we did with the capacitor.  Double-click the resistor and change it’s value to 2.  Your schematic should now appear similar to that in Fig. 4.
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Figure 3.  Partial screenshot showing placed capacitor with value set to 100 nF and IC set to 1 V and made visible.
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Figure 4.  Partial screenshot showing placed resistor with value set to 2 Ohms.

Next, we need to add two wires to connect the components.  Switch to wiring mode by selecting the wiring tool from the parts toolbar (fourth button from the left) or by pressing the “W” key on your keyboard.  A pencil icon will now follow the mouse.  Move this pencil tip to the top terminal of the capacitor until that terminal is highlighted (changes color and becomes filled in black).  Now, move the mouse vertically and then to the right toward the resistor’s left terminal.  You should see a solid vertical wire extending from the capacitor’s top terminal and a dashed horizontal wire to the current mouse position.  Note that you can escape from wiring mode by selecting the part select tool (or any other tool).  Move the mouse to highlight the left terminal of the resistor and then click the mouse to complete the wire.  The schematic should now appear as in Fig. 5.  Note that wired terminals are hidden.  If a wire end does not connect to a part, a terminal appears at the end of the wire.  You can delete a wire segment (or a part) by selecting them with the part select tool and pressing the “Delete” key on your keyboard.  You can select multiple parts by dragging a box around several parts while in part select mode.  Selected parts appear in red.
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Figure 5.  Partial screenshot showing placed resistor with value set to 2 Ohms.

Next, draw a wire from the bottom terminal of the capacitor to the right terminal of the resistor using the same technique.  Note that part labels can be moved by selecting them with the part select tool and then dragging them to the new location.
The final step is to place the ground node.  Select the ground tool from the parts toolbar (eight from the left) and move the mouse to the bottom terminal of the capacitor.  Once over this terminal, the terminal will be highlighted.  Click the left mouse button to place the ground at the bottom capacitor terminal.  The ground is then placed and a node symbol appears at the junction of the capacitor terminal, wire to the resistor, and the ground’s terminal.  Node symbols mark the junction of more than two terminals.  Your schematic should now appear as in Fig. 6.  Note that the ground terminal could also have been rotated and/or placed on the resistor’s right end or the wire between resistor and capacitor with the same affect.  (Note:  Ground terminals are not required at simple connections between transmission-line elements)
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Figure 6.  Partial screenshot showing completed RC schematic.

The schematic entry of this simple RC circuit is now complete.  Before simulating you may examine the automatically generated netlist by clicking the “View Netlist” button the simulator toolbar.  The result should appear as in Fig. 7.  This netlist is very similar to that used in SPICE (in fact, simple netlists are usable without modification in SPICE).  This circuit contains two nodes, “N5” and “0”.   “0” represents the ground node and “N5” is an automated name for the connection from the positive terminals of capacitor and resistor.  Note that the positive terminal is listed first, followed by negative terminal, then part value in the netlist.  Note that CASTLE internally treats capacitors as single timestep long transmission-line elements with center and outer conductors tied together to provide two terminals.
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Figure 7.  Netlist for simple RC circuit.

Before simulating, it is advised to save your schematic.  Do this by selecting “Save” from the menu or pushing the save button on the main toolbar.  By default, CASTLE schematics have a “.cas” filename extension.

Simulate this simple RC circuit by pushing the “Simulate” button the simulator toolbar.  The simulator dialog box appears where you can select the time step, time span and start time (note that end time = start time + time span).  The netlist is also shown and can be edited here to make quick changes without changing the schematic.
Change the “Time Span” to “1000NS” and push the “Simulate” button.  You should then quickly see a “Simulation completed” message.  When you click “OK”, the “Select Traces” dialog automatically appears.  Here you select traces to plot or export.

The available traces are broken down into several categories in the top left list box, “Trace Type:”.  Select “Part Voltages” and “V(C1)” and “V(R1)” should appear in the top right list box, “Trace List”, where they can be selected by double-clicking.  Select both V(C1) and it should be added the “Selected Traces” text box.  Now, click the “Plot Traces” button to see a plot of V(C1) versus time.  You can zoom into a portion of the plot by holding down the “Shift” button and dragging a box over the portion to zoom to.  Note that the regular zoom in and out buttons also work, but they scale the plot without changing the range of data displayed.
You can close this plot by selecting “Close” from the “File” menu or by clicking the smaller “x” in the top right corner inside the main window.  Do not push the big “X” of the main window or you’ll close CASTLE!  You could also just leave the plot and return to the schematic by selecting the schematic window from the window list in the “Window” menu.  Windows can also be cascaded or tiled.

TIP:  You can make further plots or export data without simulating again.  Just return to the schematic and push the “Trace Select” button, which becomes usable only after the schematic has been simulated.  All simulation data remains in memory until the schematic is closed.

Adding Probes to the Schematic

You may find that you always want to plot a certain voltage or current in a simulation.  The voltage and current probe parts allow you to place probes on the schematic whose trace is automatically added the “Selected Traces” box after simulation.  In the simple RC schematic previously described, we can add a voltage probe to positive terminal of the capacitor by pushing the “Voltage Probe” part button on the part toolbar (10th from the left) and then placing the probe, e.g., on the top-left bend in the wire that connects C1 and R1.  Note that this bend should be highlighted when placing to ensure proper connection.  The schematic should now look as shown in Fig. 8.
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Figure 8.  Voltage probe added to simple RC circuit schematic.

Now, you can see in the netlist that the node name for the positive ends of C1 and R1 has been renamed to “P1”, the probe name.  Also, after simulating, you will see that “V(P1)” is automatically added to the “Selected Traces” box, allowing for quick plotting or saving.

We can also add a current probe to the circuit.  Select and delete the wire going downward from the right end of R1.  Switch to current probe placement mode by clicking the current probe button in the part toolbar (third from the right) rotate the probe, if desired, by pressing “R” once.  Then place the probe where the wire was.  The probe will be labeled “V1”.  Note that in CASTLE (as well as SPICE) current probes are implemented as voltage sources with their voltage set to zero.

Use wires to connect the probe to the resistor and existing wire by entering wiring mode (press “W”) and drawing wires between terminals.  The schematic should now look similar to Fig. 9.  After simulating, “I(V1)” will be added automatically to the “Selected Traces” box.
TIP:  Remember that you can use Undo/Redo to correct mistakes.
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Figure 9.  Current probe added to simple RC circuit schematic.

Adding Text Labels to the Schematic
The text tool (third from the left on the part toolbar) allows you to place text labels on the schematic.  Note that normal text will not affect the netlist.  When you select the text tool a dialog box will prompt you to enter the desired text.  You can then place this text in one or more places on the schematic.  Edit text labels by double-clicking them.

Using Text Parameters

Text labels that begin with the keyword “PARAMS:” are utilized to allow easy setting of frequently changed part values or parameters.  For example, with the simple RC schematic, change the value of the resistor from “2” to “RLOAD”.  Next, create and place a text label with the text “PARAMS:  RLOAD=2”.  You can check the netlist to verify that R1 is assigned the value of 2.  An example is shown in Fig. 10.  Parameters are also used to pass values to subcircuits, described later.
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Figure 10.  Example of using text labels to set simulation parameters.

Transmission-Line Circuit Example:  Simple Pulsed-Power Circuit

This example demonstrates how to use transmission-line elements in CASTLE.  Select “New” from the “File” menu (or push the “New” button the main toolbar) and then pick “Castle Schematic” from the dialog.  (Note:  you could also just add this circuit to a empty area of the previous schematic if you wanted.  A single schematic can contain any number of independent circuits.)  

Place three transmission-line elements on the schematic using by pushing the transmission-line placement button on the parts toolbar and then clicking the mouse on the schematic.  Place the elements as shown in Fig. 11.  Note that transmission-line elements can be rotated (using the “R” key on the keyboard) and will rotate about the left, positive (center) terminal.  But, place these elements in the default orientation.
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Figure 11.  Three transmission-line elements placed on the schematic.

Notice that the CASTLE automatically recognizes that T2 and T3 are joined and the terminals at the junction are hidden.  It is not required to place a ground node at this junction.

Double-click the elements to edit their values.  Change T1 to Z0= 3, TD= 25n, IC= 4MEG, and make the IC visible.  Change T2 to Z0= 3, TD= 10n.  Change T3 to Z0= 1.5, TD= 50n.
Place a switch element between the center terminals of T1 and T2.  (the switch placement mode button is fourth from the right on the parts toolbar).  Then, place a resistor at the end of T3 (resistor part button is the left button).  If you want, rotate the resistor to the vertical position using the “R” button on the keyboard either before placing or after by first selecting the resistor with a mouse click.  Change the resistor value to 2.  You can view the switch settings by double-clicking on it.  But, this example will use the default settings.
Use wires to connect center terminals of T1 and T2 to the switch ends and to connect the outer terminals of T1 and T2 to each other.  Use wires to connect T3 to the resistor.  The schematic should now look like Fig. 12.  Note that no connection is required on the left end of T1.

[image: image12.png]



Figure 12.  Basic transmission-line circuit wired with switch and resistor.

Explicit grounding is required for some transmission-line junctions, but CASTLE automatically assigns ground for several types of junctions.  (If desired, push the “Netlist” button to examine how ground nodes are assigned).  The left end of T1 is open and CASTLE will assign ground to the left outer conductor terminal.  The outer conductors of T1 and T2 are connected and neither of the center conductors attached to S1 are explicitly grounded, so CASTLE automatically assigns ground to the connected outer conductors.  T2 and T3 are directly connected, so CASTLE automatically assigns ground to the connected outer conductors.  
T3, however, is connected only to a parallel resistance.  At this time, this type of connection requires an explicit ground.  If you push the “Simulate” button at this time, you will get an error message that a node is floating.  If you then were to examine the netlist, you will see that this is one of the nodes connecting T3 and R1.

Add an explicit ground terminal to the bottom terminal of R1 using the ground tool (8th button from the left on the parts toolbar).  The completed schematic is shown in Fig. 13.
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Figure 13.  Completed schematic of basic transmission-line circuit.

You can now simulate this circuit by pressing the “Simulate” button on the simulation toolbar.  Change the time span to “200n” and begin the simulation by pushing the “Simulate” button in the simulation dialog box.  

TIP:  These simple simulations will finish instantly.  However, you may have more complicated simulations that can take several minutes and make the computer less responsive.  If this happens and you wish to stop the simulation before it is complete, push the “Abort” button in the simulation dialog box.  It may take a few seconds to take affect, but this will end the simulation early.  Note that all simulations results are still available for the completed portion.  A progress bar in the dialog indicates how much of the simulation has been completed.
Once the simulation is complete you can select which traces to plot in the trace select dialog that appears after acknowledging completion of the simulation.  For example, to select the current in R1 click on “Part Currents” in the left list and then “I(R1)” in the right list.  You can also select transmission-line voltage, current, or waves in the left list.  The last letter “R” or “L” in the trace names in the right list indicates the right or left end location of the measurement.  For example, to plot the voltage at the left end of T1, select “VL(T1)”.  There are two waves at each end of a transmission-line, V1 and V2.  V1 refers to the wave leaving an end and V2 refers to the wave entering an end.  For example, to select the wave entering the right end of T3, double-click on “V2R(T3)”.
Note:  One advantage of CASTLE over most TL codes is the unrestricted topology.  In this example, you can simply connect a capacitor across S1, if desired.  You could also add resistors from either end of S1 to ground.  Just be aware that in more complicated junctions you may have to specify the ground node.
Using Bubble Connectors

For large schematics, you may want to use bubble connectors instead of drawing long wires across the schematic.   Bubble connectors are also used subcircuits (described later).  In the previous example, one could separate the circuit in two parts at the T2-T3 junction using bubble connectors.  To demonstrate, first select the right part of the circuit, including T3 and R1 and drag them to the right a few grid points.
TIP:  You can drag multiple components by selecting the all and the dragging them (with the left mouse button held down).  You can select multiple components by either dragging a box around them while in part select mode and/or by clicking on them with the “Ctrl” key held down.  Selected parts will appear in red.  You can also copy, cut, and paste selected components.

Next, add bubble connectors  to the center connectors of  the right side of T2 and the left side of T3 by pushing the bubble placement mode button on the parts toolbar (sixth from the right) and clicking on the desired terminals once they are highlighted.  Note that bubble connectors can also be rotated using the “R” key on the keyboard.  Ensure that the two bubble connectors have matching labels, such as “A”, so that CASTLE will recognize them as being connected.  Do not use numbers for bubble labels as these are reserved for subcircuit pin designations.  The schematic should now look like that of Fig. 14.  If you view the netlist you will notice that the only change is that the common node of T2 and T3 center conductors is now called “A”, same as the bubble label.  If you simulate this example you will get the same result as before.  

Note neither bubbles are grounding is required for the outer conductors of T2 and T3 because they have a simple connection.  For a more complicated connection, either explicit grounding or bubbles must be used.
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Figure 14.  Transmission-line circuit example using bubbles to connect isolated segments.

Subcircuits

Using subcircuits, you can represent a portion of one schematic with another schematic.  This can be very useful when several instances of the same subcircuit in a main schematic.  As an example, the same simple transmission-line example from the previous example will be split into a main schematic and a subcircuit schematic.

First, selected the entire right side of the circuit including T3, R1, and the right bubble connector.  (You may want to save the current file under a different name at this point.) Click “Cut” from the “Edit” menu or push the scissors icon on the main toolbar to copy this subcircuit to the clipboard and remove it from this schematic.  Next, select “New” from the “File” menu and create a new schematic.  Paste the previously cut subcircuit into the new schematic.  Rename the bubble connector from “A” to “sub1” (sub1, sub2, sub3, and sub4 are reserved keywords).  The new subcircuit should look like that in Fig. 15.  Note that the part labels may change when pasting them (T3 becomes T1 in the new schematic).  This is to avoid duplicate part names within the same schematic.  Just rename parts to their previous values.  This in not really required though because subcircuit part labels can be the same as the main circuit without problems.  Now, save this file with a new name and return to the main schematic (use the “Windows” menu to switch between schematics).
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Figure 15.  An example subcircuit schematic.

Next, delete the bubble on the main schematic and replace it with a subcircuit element (the subcircuit mode tool button is second from the right on the parts toolbar).  Place the subcircuit element just to the right of T2, but leave a space between terminals.  Then, draw a wire from the left, center terminal of T2 to the “1” pin of the subcircuit element, “X1”.  The main circuit should now appear as in Fig. 16.  Note that you could have connected up the outer conductor terminal to pin 2, but this is not necessary since the ground node is common to all schematics.
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Figure 16.  An example circuit utilizing a subcircuit element.

Finally, you must tell the subcircuit element which schematic file contains the subcircuit it represents.  Double-click the subcircuit element to bring up the settings dialog.  Click the “Browse” button and find the file containing the subcircuit previously saved.  Note from this dialog you can examine the subcircuit by clicking the “Open” button and then hide it again with the “Close” button.

One can also pass parameters to the subcircuit.  This is useful when there are several instances of the same subcircuit but with some different element values.  In this example, you can enter “Rload=2” in the “Parameters” text box in the subcircuit element edit dialog and then change the resistance of the R1 in the subcircuit from “2” to “Rload”.  Note that you must save the subcircuit schematic for changes to take affect in the main circuit.
If you new “View Netlist” in the main schematic you can verify that the parameter value was passed.  Each subcircuit element will have it’s own section in the netlist and it’s node names with have an underscore and then the subcircuit label as a suffix.  If you then simulate this circuit and begin selecting traces, be aware that the part names for those parts in a subcircuit  will also have their labels appended by an underscore and the subcircuit label.  This is to ensure unique names when several instances of a subcircuit are present.

Note that this example only uses 1 of 4 available nodes for the subcircuit.  And, since the ground node is common, the subcircuit can actually share 5 nodes with the main circuit.  

TIP:  It is possible to have subcircuits within subcircuits.  Also, you can pass parameters from the main circuit to these sub-subcircuits.  This can be achieved, e.g., by passing a parameter like “RLoad2=Rload” from the subcircuit to the sub-subcircuit and also passing “Rload=2” from the main circuit to the subcircuit.  In a similar way, you can use text parameter labels in the main schematic, e.g., “PARAMS:  Rload=2”, to pass parameters to subcircuits.
Voltage and Current Sources
Voltage and current sources are available in CASTLE.  They can both represent a  DC or pulsed source.  They can also take a Stella waveform as a source function.  You can find them on the parts toolbar.
A Note about Inductors

As previously mentioned, inductors are treated as single timestep long transmission-line elements inside the simulator.  But, only two terminals are provided for the schematic symbol.  This is because both outer conductors are internally treated as ground.  It may be that this could cause an issue in some circuit topology, but no topology has yet been found where this was a problem.  But, if you happen to find a problem topology, just use a regular transmission-line element to represent the inductor.
Variable Capacitor


A variable capacitor is a new addition to the available parts.  It can either follow a user supplied polynomial function (as in SPICE) or one or two know capacitor types.

Custom Parts

It is relatively easy to program new, custom parts.  Several parts have already been transferred from the transmission-line code, Bertha, into CASTLE.  Several are not provided at this time because they are still being tested.  Future versions may have the ability for user generated parts based on script files.

Iteration

Some of the custom parts just mentioned require iteration within a time step and so iteration has been implemented in CASTLE, however, none of the parts provided at this time use iteration.
Printing and Pring Preview

Print and Print Preview function just as in many Windows programs.  Note that you will probably want to use the “Print Setup” function to specify “Landscape” mode so that your schematic can fit the page.

Page Size
Larger page sizes can be selected from the “Edit” menu.  These may be useful for larger schematics.  You can change the page size at any time.

A Note about Wires and the Grid
Wiring is currently not implemented as well as in other schematic entry programs, but this will be improved in the future.  Also, note that wires do not necessarily snap to the grid as parts do, so wires may be off the grid.  

Bugs and Errors

CASTLE is a relatively new and complex code considering the programming staff (just me).  So, there are undoubtedly bugs and/or errors in the code.  If you find a reproducible flaw, please email me with the info.
Copyright 2006 Raymond Allen
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